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Chương 4. PHAÂN TÍCH MOÁI LIEÂN HEÄ GIÖÕA 
CAÙC LOAØI CAÂY TRONG QUAÀN XAÕ

• Noäi dung
Chöông 4 xem xeùt hai vaán ñeà:

1. Kieåm ñònh söï keát nhoùm giöõa caùc loaøi
2. Tính cöôøng ñoä keát nhoùm giöõa caùc loaøi
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Söï phuï thuoäc giöõa caùc loaøi coù theå nghieân cöùu treân ba möùc ñoä khoâng
gian khaùc nhau:

(1) Treân möùc ñoä ñòa lyù
Xaùc ñònh söï cuøng chung soáng cuûa caùc loaøi trong moät ñòa phöông vaø

ñaùnh giaù söï truøng hôïp (hay söï giao nhau) cuûa chuùng trong caùc vuøng ñòa
lyù.

4.1. GIỚI THIỆU CHUNG
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(2) Treân möùc quaàn xaõ
Xaùc ñònh söï lieân heä phuï thuoäc (keát nhoùm) giöõa caùc loaøi.
Xaùc ñònh khaû naêng cuûa caùc loaøi tham gia vaøo cuøng moät QXTV vaø
nhöõng nhaân toá kieåm soaùt söï soáng cuûa chuùng.
Xaùc ñònh söï truøng hôïp bieân ñoä sinh thaùi cuûa caùc loaøi. Ñôn vò ño ñeám laø
oâ tieâu chuaån coù kích thöôùc lôùn (0,1-1,0 ha).

Chương 4. PHAÂN TÍCH MOÁI LIEÂN HEÄ GIÖÕA 
CAÙC LOAØI CAÂY TRONG QUAÀN XAÕ
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(3) Treân möùc giöõa caùc loaøi trong cuøng moät QXTV
Xaùc ñònh quan heä qua laïi (keát nhoùm) giöõa caùc loaøi. Ñôn vò ño
ñeám laø oâ coù kích thöôùc nhoû (1 - 500 m2). 
Tính quan heä giöõa caùc loaøi baèng töông quan haïng vaø nhöõng
thoáng keâ khaùc.

Chương 4. PHAÂN TÍCH MOÁI LIEÂN HEÄ GIÖÕA 
CAÙC LOAØI CAÂY TRONG QUAÀN XAÕ
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(1) Töông quan haïng
Caùch giaûi quyeát
Trước hết thoáng keâ ñoä phong phuù cuûa töøng loaøi trong oâ tieâu
chuaån
Kế đñến xeáp haïng ñoä phong phuù cuûa töøng loaøi
Sau ñoù tính töông quan haïng giöõa hai loaøi

4.2. XÁC ĐỊNH MỐI LIÊN HỆ GIỮA 
CÁC ĐẠI LƯỢNG
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Ví duï. Tìm töông quan giöõa ñoä phong phuù cuûa hai
loaøi A vaø B (baûng 4.1).

4.2. XÁC ĐỊNH MỐI LIÊN HỆ GIỮA 
CÁC ĐẠI LƯỢNG
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Cách xây dựng dãy phân hạng
Trước hết, sắp xếp các số hạng của hai dãy
nghiên cứu theo thứ tự từ nhỏ đến lớn. 
Hạng một là số hạng nhỏ nhất, còn hạng n 
là số hạng lớn nhất. 
Nếu một giá trị bắt gặp nhiều lần, thì thứ tự
của hạng là giá trị bình quân của những trị
số đó. 

4.2. XÁC ĐỊNH MỐI LIÊN HỆ GIỮA 
CÁC ĐẠI LƯỢNG
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Ở ví dụ của bảng 4.1, trước hết chúng ta cần
phải biết thang đo độ phong phú của Druze.
Kế đến, mã hóa các độ phong phú bằng
những giá trị nào đó.
Sau đó, thực hiện xếp hạng đo độ phong
phú theo những số mã hóa.

4.2. XÁC ĐỊNH MỐI LIÊN HỆ GIỮA 
CÁC ĐẠI LƯỢNG
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Baûng 13.1. Phaân caáp ñaùnh giaù ñoä phong phuù cuûa caùc loaøi
hoøa thaûo döôùi taùn röøng theo phaân caáp Druze

Phaân chia theo heä thoáng 7 caáp

  Chæ tieâu vaø tieâu chuaån ñaùnh giaù:
Phaân caáp
Druze

   Kí hieäu baèng soá
  theo löôïng caù theå    theo % ñoä che phuû

Soc(*)

Cop3

Cop2

Cop1

Sp
Sol
Un

6
5
4
3
2
1
0

  raát nhieàu
  nhieàu
  töông ñoái nhieàu
  töông ñoái
  ít
  raát ít
  chæ moät caù theå

76 - 100
51 - 75
21 - 50
 5 - 20
 1 -  4
 döôùi 1

   döôùi 0,2
(*) Caùc kyù hieäu vieát taét töø  chöõ La Tinh:
Socialis = Soc, Copiosus = Cop, Spars = Sp, Unicus = Un
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Từ ví dụ ở bảng 4.1 cho thấy:
Trị số độ phong phú của loài A ở ô thứ 11
(sol-sp) là nhỏ nhất, nên nó được xếp hạng
1. 
Tiếp theo độ phong phú Sp xuất hiện ở 10 ô 
mẫu, do đó hạng của những ô này là (2 
+11)/2 = 6,5. 
Tương tự như trên, chúng ta phân hạng cho
những ô khác của cả hai loài A và B.

4.2. XÁC ĐỊNH MỐI LIÊN HỆ GIỮA 
CÁC ĐẠI LƯỢNG
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ρ   =   

n3 - n
 6   - (Tx - Ty) - ∑d2

 
n3 - n

 6   - 2Tx 
n3 - n

6   - 2Ty
 

Heä soá töông quan haïng

Khi coù nhieàu giaù trò cuøng haïng

ρ  =  1  -  
6 ∑ d 2

 n 3  -  n    ( 4 .8 )
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4.2. XÁC ĐỊNH MỐI LIÊN HỆ GIỮA 
CÁC ĐẠI LƯỢNG

∑d2 = toång cheânh leäch bình phöông cuûa trò soá haïng
trong moãi caáp.
n = soá oâ ño ñeám.
Tx vaø Ty = trị số hiệu chỉnh – đñoù laø kết quả của
sự lieân kết một số cấp.
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4.2. XÁC ĐỊNH MỐI LIÊN HỆ GIỮA 
CÁC ĐẠI LƯỢNG

trong đó
i = 1, 2,..., l với l là số cấp; 
t = số ô lặp lại theo mỗi cấp hoặc tần số
của mỗi cấp. 
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4.2. XÁC ĐỊNH MỐI LIÊN HỆ GIỮA 
CÁC ĐẠI LƯỢNG

Ví duï
Từ ví dụ ở bảng 4.1 có thể thấy:
Đối với loài A, TA = (990/12) + (120/12) + 
(60/12) = 97,5.
Đối với loài B, TB = (336/12) + (1716/12) = 171. 
∑d2 = (14 –15,5)2 + (19,5 – 15,5)2 + ... + (17 –
15,5)2 = 1061,5. 
Từ đó tính được ρ = + 0,295. 
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4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI

Ñaët vaán ñeà
1. Nhöõng loaøi caây soáng beân caïnh nhau trong QXTV coù

quan heä (keát nhoùm) vôùi nhau hay khoâng?
2. Neáu chuùng coù quan heä vôùi nhau, thì moái quan heä ñoù

laø thuaän (döông) hay nghòch (aâm)?
3. Cöôøng ñoä cuûa moái quan heä cao hay thaáp?
4. Cô cheá cuûa moái quan heä heä giöõa caùc loaøi?
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• 5. Phöông phaùp xaùc ñònh söï keát nhoùm giöõa caùc loaøi ?

• 6. Muïc ñích (yù nghóa) xaùc ñònh söï keát nhoùm giöõa caùc
loaøi caây?

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI

Sự kết nhóm giữa hai hay nhiều loài cây
trong quần xã thực vật có thể biểu hiện ở 4 
dạng khác nhau:
Không có kết nhóm
Kết nhóm âm
Kết nhóm dương
Sự phụ thuộc phức tạp.
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a. Không tồn tại sự kết nhóm
Điều đó có nghĩa là sự thay đổi độ phong phú của
loài này không kéo theo sự thay đổi độ phong phú
của loài khác. 
Bản chất của hiện tượng này là các loài phân bố 
độc lập với nhau. 
Sự cùng có mặt của các loài ở một nơi ở nào đó có
thể là do chúng có biên độ sinh thái giống nhau. 

Chương 4. PHAÂN TÍCH MOÁI LIEÂN HEÄ GIÖÕA 
CAÙC LOAØI CAÂY TRONG QUAÀN XAÕ
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4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI

b. Sự kết nhóm âm
Kiểu kết nhóm này cho biết sự gia tăng độ
phong phú của loài này kéo theo sự suy
giảm độ phong phú của loài khác. 
Bản chất của hiện tượng này là sự cạnh
tranh giữa các loài.
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c. Sự kết nhóm dương
Kiểu kết nhóm này cho biết sự gia tăng độ phong
phú của loài này kéo theo sự gia tăng độ phong
phú của loài khác. 
Bản chất của hiện tượng này có thể là sự cộng sinh
giữa các loài hoặc sự hỗ trợ lẫn nhau giữa các loài
trong quá trình sống. 
Từ mối liên hệ dương giữa các loài, chúng ta xác 
định được những nhóm sinh thái hoặc nhóm sinh
học. 

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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d. Sự phụ thuộc phức tạp
Đây là mối liên hệ giữa hai loài biểu hiện
dưới dạng đường cong hình chữ U.

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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PHÖÔNG PHAÙP
1. Duøng baûng cheùo (2*2) hay (R*C) ñeå xaùc ñònh

moái quan heä (hay tính ñoäc laäp) giöõa hai loaøi
baèng kieåm ñònh Chi - square.

2. Neáu hai loaøi coù quan heä vôùi nhau, thì bước tiếp
theo tính cöôøng ñoä moái quan heä giöõa hai loaøi. 

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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TRÌNH TÖÏ TÍNH TOAÙN
(1) Xaùc ñònh moái quan heä (hay tính ñoäc laäp) giöõa

hai loaøi baèng kieåm ñònh Chi - square.
• Thuû tuïc

Thoáng keâ ñoä baét gaëp loaøi (Coù = 1, khoâng coù = 0)
Laäp baûng cheùo 2*2 hoaëc R*C
Kieåm ñònh tính ñoäc laäp baèng thoáng keâ Chi -
square

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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Baûng cheùo 2*2 hay R*C

a b (a+b)
Loaøi B (a') (b')

c d (c+d)
(c') (d')

(a+c) (b+d) N

Loaøi A

(+)

(-)

(+) (-)

Toång

Toång
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trong ñoù:
a = taàn soá oâ cuøng xuaát hieän 2 loaøi A vaø B
b = taàn soá oâ chæ xuaát hieän loaøi B
c = taàn soá oâ chæ xuaát hieän loaøi A
d = taàn soá oâ vaéng maët caû hai loaøi A vaø B
(a + b) = toång soá oâ treân ñoù gaëp loaøi B
(a + c) = toång soá oâ treân ñoù gaëp loaøi A
N = toång soá oâ nghieân cöùu.

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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χ2
TT = 

(ad - bc)2 N
 (a+b)(c+d)(a+c)(b+d) 

Kieåm ñònh Chi - Square
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Giaû thuyeát H0: Hai loaøi A vaø B khoâng coù
quan heä vôùi nhau (ñoäc laäp)

Quy taéc quyeát ñònh

Neáu χ2 < χ2
0.05 hoaëc P > 0,05 ⇒ H0

+

Neáu χ2 > χ2
0.05 hoaëc P < 0,05 ⇒ H0

-
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(2) Khi hai loaøi coù quan heä vôùi nhau
Chuùng ta caàn phaûi xaùc ñònh cöôøng ñoä cuûa
moái quan heä. 
Tham khaûo taøi lieäu “Nguyeãn Vaên Theâm, 
2004. Höôùng daãn söû duïng Statgraphics
Plus Version 3.0 & 5.1 ñeå xöû lyù thoâng tin 
trong laâm hoïc”, Nxb. Noâng nghieäp, Chi 
nhaùnh Tp. HCM.

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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4.3.2. Xác định cường độ kết nhóm giữa các loài

(A) Khi boû qua soá oâ khoâng baét gaëp hai loaøi

(1) Heä soá Forbes (1925): F = a/a’ (4.14)

Khi hai loaøi ñoäc laäp vôùi nhau, thì F = 1.
Khi moái lieân heä nghòch, thì F = 0, vì a = 0.

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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(2) Heä soá töông quan giaûm cuûa Pearson

R =   
ad - bc

 (a + b)(a + c)(b + d)(c + d) 
 R =   

ad - bc
 (a + b)(a + c)(b + d)(c + d) 

 (4.15)
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(4.17)

(3) Heä soá Yule (1920)

Q = 
ad - bc
 ad + bc 

Heä soá Q = -1 ñeán + 1
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(4) Heä soá Cole (1949)

Khi moái lieân heä döông, nghóa laø ad > bc:

C = 
(ad - bc)

 (a +b)(b + d)  
(4.18)
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Khi moái lieân heä aâm, nghóa laø ad < bc:
Neáu a ≤ d, ta coù :

C = 
(ab - bc)

 (a +b)(a + c) C = 
(ab - bc)

 (a +b)(a + c) 
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Neáu a > d, ta coù:

C = 
(ad - bc)

 (b +d)(c + d) C = 
(ad - bc)

 (b +d)(c + d) 
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Ví duï:

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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Keát quaû tính toaùn:

Heä soá Cole: C = + 0,30

Heä soá Forbes: F = 1,54

Heä soá Yule: Q = + 0,48

Heä soá töông quan giaûm: R =  + 0,22
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(5) Heä soá lieân heä cuûa Morisita (1959)

o Tröôùc heát tính heä soá: 

B. Nhöõng heä soá lieân heä coù tính ñeán soá caây/oâ
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Trong ñoù:
q = soá oâ nghieân cöùu (i = 1,2... q); 
nxi vaø nyi = soá caù theå cuûa loaøi X vaø Y 
treân oâ nghieân cöùu thöù i; 
Nx vaø Ny = toång soá caù theå cuûa loaøi X 
vaø Y treân caùc oâ nghieân cöùu.

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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Quy taéc quyeát ñònh:
Neáu Rδ’ > 0, thì Rδ = Rδ’.
Neáu Rδ’ < 0, thì moái lieân heä giöõa hai
loaøi tính theo coâng thöùc:

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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• (6)Heä soá Dice (1945)
Tuøy theo loaøi A hay B laáy laøm cô sôû so 
saùnh, Dice ñöa ra heä soá:

• Caùc soá a, b vaø c = kí hieäu taàn soá cuûa baûng 2* 2.

B/A = 
a

 (a + b)  vaø A/B = 
a

 (a + c) (4.24)(4.27)
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a, b và c = những kí hiệu của bảng 2*2 
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Khi keå ñeán soá oâ khoâng gaëp hai loaøi
(8) Heä soá Fager (1957)

Neáu goïi nA vaø nB töông öùng laø soá oâ gaëp
loaøi A vaø B, thì soá oâ lyù thuyeát cuøng gaëp hai
loaøi khi chuùng phaân boá ñoäc laäp laø

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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Nếu I thực tế lớn hơn I lý thuyết tính theo 
công thức 4.29, thì hai loài có mối liên hệ 
dương.
Ngược lại, trị số I thực tế nhỏ hơn I lý 
thuyết, thì hai loài có mối liên hệ nghịch.

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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Để đánh giá sự khác nhau giữa tần số lý 
thuyết và tần số thực nghiệm của độ bắt gặp 
cả hai loài trên cùng một ô mẫu, Fager dùng 
công thức:

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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(9) Hệ số tương quan biên độ của Bray

• Sj = số ô bắt gặp cả hai loài
• SA và SB = số ô bắt gặp loài A và loài B. 

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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(10) Hệ số kết nhóm của Morisita (1959)

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI

q = số ô nghiên cứu (i = 
1,2...q); 

nXi và nYi = số cá thể của loài 
X và Y trên ô nghiên cứu thứ i; 

NX và NY = tổng số cá thể của 
loài X và loài Y trên tất cả các ô 
nghiên cứu. 
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Khi mật độ của loài X và Y trên các ô mẫu 
không khác nhau, thì Cδ = 1.
Khi hai loài không cùng đi kèm với nhau, 
thì Cδ =  0.

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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Tính sự kết nhóm khi độ che phủ của các 
loài được chia thành nhiều cấp

• Cách giải quyết:

Phân chia độ phong phú của các loài theo cấp (>= 3 
cấp).

Tính tần số lý thuyết cho các cấp

Kiểm định bằng thống kê χ2 với số bậc tự do là (S -
1)(t - 1); trong đó S là số dòng, còn t là số cột.

Sau đó tính hệ số kết nhóm giữa hai loài

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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Ví dụ:

Khi độ che phủ của các loài được 
chia thành nhiều cấp
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• Khi độ phong phú được chia thành nhiều
cấp, chúng ta có thể tính sự kết nhóm giữa
hai loài theo ba hệ số:

Hệ số töông quan giaûm

Hệ số Pearson

Hệ số Truprov

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI



11/11/2009 54

(11) Hệ số töông quan giaûm

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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(13) Hệ số Truprov

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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Từ ví dụ của bảng 4.3, ta có:
Hệ số tương quan giảm: R = 0,370
Hệ số Pearson: r = 0,350
Hệ số Truprov: T = 0,261

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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KIEÅM ÑÒNH TÍNH ÑOÄC LAÄP CUÛA HAI LOAØI 
BAÈNG PHAÀN MEÀM SPSS 10.0

4.3. XÁC ĐỊNH SỰ KẾT NHÓM 
GIỮA CÁC LOÀI
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(a) Ñieàu kieän aùp duïng
Moät laø, vai troø cuûa bieán phuï thuoäc vaø bieán ñoäc laäp laø
khoâng roõ raøng. Ñieàu ñoù coù nghóa laø coù theå xem bieán
naøo laø bieán phuï thuoäc hay bieán ñoäc laäp ñeàu ñöôïc.
Hai laø, vieäc kieåm ñònh quan heä giöõa 2 bieán ñònh tính
khoâng coù thöù baäc ñöôïc thöïc hieän baèng baûng 2*2 hoaëc
baûng R*C oâ. 

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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(b) Noäi dung kieåm ñònh
Moät laø, hai loaøi caây coù quan heä vôùi nhau hay khoâng? 
Caâu hoûi naøy ñöôïc laøm roõ baèng kieåm ñònh Chi –
Square. 
Neáu P > α (0.05 hay 0.01) ⇒ coù quan heä.
Ngöôïc laïi, P < α⇒ ñoäc laäp. 

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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Hai laø, neáu hai ñaïi löôïng coù quan heä vôùi nhau, thì
cöôøng ñoä cuûa moái quan heä giöõa hai ñaïi löôïng laø maïnh
hay yeáu?
Caâu hoûi naøy ñöôïc laøm roõ baèng kieåm ñònh Phi, 
Contingency coefficient, Cramer’s V,  Lambda.

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH TÍNH 
KHOÂNG COÙ THÖÙ BAÄC
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(c) Phương phaùp thu thaäp döõ lieäu, caùch vaøo döõ lieäu vaø
goïi chöông trình tính toaùn cuõng töông töï nhö kieåm
ñònh tính ñoäc laäp giöõa hai loaøi caây.

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH TÍNH 
KHOÂNG COÙ THÖÙ BAÄC
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Keát quaû cho 4 baûng sau ñaây:

Thoáng keâ toùm taét xöû lyù caùc tröôøng hôïp

Baûng cheùo

Kieåm ñònh Chi – square

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH TÍNH 
KHOÂNG COÙ THÖÙ BAÄC
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Nhöõng ño ñaïc veà xu höôùng moái quan heä (Directional 
Measures) vaø nhöõng ño ñaïc veà tính ñoái xöùng
(Symmetric Measures) trong caùch saép xeáp cuûa hai ñaïi
löôïng cuûa baûng 2*2 (hay R*C oâ). 

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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Kieåm ñònh tính ñoäc laäp cuûa hai ñaïi löôïng
Thoáng keâ kieåm ñònh tính ñoäc laäp
Pearson χ2 

Continuity Correction (heä soá hieäu chænh)
Likelihood Ratio (tyû leä ñoàng nhaát)
Fisher's Exact Test

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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THUÛ TUÏC KIEÅM ÑÒNH TÍNH ÑOÄC LAÄP CUÛA HAI LOAØI 

(1) Phaàn meàm Statgraphics Plus Version 3.0 & 5.1

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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1. KIEÅM ÑNH χ2

1.1. Kieåm ñònh veà tính ñoäc laäp cuûa caùc ñaïi löôïng
Böôùc 1. Thu thaäp döõ lieäu veà söï baét gaëp loaøi: coù maët = 1; 
khoâng coù maët = 0
Böôùc 2. Nhaäp döõ lieäu. Moãi coät nhaäp 1 loaøi
Böôùc 3. Goïi leänh Describe ⇒ Categorical Data ⇒
Crosstabulation ⇒ Row ⇒ Column ⇒ Tabular Option ⇒
All ⇒ OK. 

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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Giaû thuyeát H0: Hai loaøi soáng ñoäc laäp vôùi nhau. 
Ñoái thuyeát H0

-: Hai loaøi coù quan heä vôùi nhau.

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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Quy taéc quyeát ñònh
Neáu P < α (0.05 hay 0.01) ⇒ H0-
Neáu P > α (0.05 hay 0.01) ⇒ H0+

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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THUÛ TUÏC KIEÅM ÑÒNH TÍNH ÑOÄC LAÄP CUÛA HAI LOAØI 

(2) Phaàn meàm SPSS 10.0 – 14.0

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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Böôùc 1. Nhaäp döõ lieäu cuûa moãi loaøi vaøo moät coät coät.
Böôùc 2. Goïi leänh: Analyze > Descriptive statistics > 
Crosstabs > ñöa loaøi A vaøo Row(s) & ñöa loaøi B vaøo
Column(s) > choïn Chi-square > OK.

1. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH KHOÂNG COÙ THÖÙ BAÄC
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ÑO CÖÔØNG ÑOÄ MOÁI QUAN HEÄ

Tieâu chuaån kieåm ñònh
• Phi
• Contingency coefficient 
• Cramer’s V
• Lambda
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GIAÛ THUYEÁT H0:
Phi = 0
Contingency coefficient = 0
Cramer’s V = 0
Lambda = 0
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Quy taéc quyeát ñònh:

Neáu P > 0.05 H0
+.

Neáu P < 0.05 H0
-.
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KIEÅM ÑÒNH CÖÔØNG ÑOÄ QUAN HEÄ HEÄ GIÖÕA HAI 
LOAØI BAÈNG PHAÀN MEÀM STATGRAPHICS 3.0

Böôùc 3. Goïi leänh: Describe ⇒ Categorical Data ⇒
Crosstabulation ⇒ Row ⇒ Column ⇒ Tabular 
Option ⇒ All ⇒ OK. 
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Böôùc 3. Choïn Statistics, sau ñoù choïn tieáp:

Phi
Contingency coefficient
Cramer’s V,  Lambda.

KIEÅM ÑÒNH CÖÔØNG ÑOÄ QUAN HEÄ HEÄ GIÖÕA HAI 
LOAØI BAÈNG PHAÀN MEÀM SPSS 10.0
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• a. Ñieàu kieän aùp duïng
Moät laø, caû hai bieán laäp baûng laø nhöõng bieán ñònh tính coù thöù
baäc hôn keùm. 

Hai laø, caùc bieán coù theå laäp thaønh nhoùm (caáp) trong baûng cheùo
goàm R*C oâ.

(2) MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH COÙ THÖÙ BAÄC HÔN KEÙM
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• b. Noäi dung tính toaùn
Xaùc ñònh moái quan heä giöõa caùc bieán baèng heä soá töông quan
haïng cuûa Spearman hoaëc caùc thoáng keâ Gamma, Somer’d

Ño ñaïc tính phuø hôïp giöõa caùc bieán hay xu höôùng quan heä
giöõa caùc bieán. 

2. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH COÙ THÖÙ BAÄC HÔN KEÙM
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Thu döõ lieäu. Thoáng keâ soá caù theå hoaëc G, V cuûa loaøi/oâ vaø saép
xeùp theo caáp taêng daàn.

Sau ñoù maõ hoaù ôû daïng soá nguyeân (1, 2, 3…= taêng daàn theo thöù
baäc)

2. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH COÙ THÖÙ BAÄC HÔN KEÙM
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ÑO CÖÔØNG ÑOÄ MOÁI QUAN HEÄ

Thoáng keâ kieåm ñònh
Gamma
Somer’s
Kadall’s tau-b
Kadall’s tau-c

2. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH COÙ THÖÙ BAÄC HÔN KEÙM
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Thuû tuïc tính toaùn baèng Statgraphics
Môû Describe ⇒ Categorical Data ⇒
Crosstabulation ⇒ Row ⇒ Column ⇒ OK. 
Choïn Tabular Option ⇒ All vaø OK. 

2. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH COÙ THÖÙ BAÄC HÔN KEÙM
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Thuû tuïc tính toaùn baèng SPSS
Böôùc 3. Choïn Statistics > Correlations > Gamma, 
Somers’d… > Continue > OK.

2. MOÁI QUAN HEÄ GIÖÕA HAI BIEÁN ÑÒNH 
TÍNH COÙ THÖÙ BAÄC HÔN KEÙM
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

Muïc ñích phaân tích söï keát nhoùm rieâng phaàn laø xaùc ñònh
nhöõng nguyeân nhaân aûnh höôûng ñeán söï phaân boá cuûa hai hay 
nhieàu loaøi.

Baûn chaát cuûa phöông phaùp laø tính heä soá töông quan khi caùc
giaù trò cuûa moät hoaëc moät soá nhaân toá khaùc ñöôïc coá ñònh.  
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

4.4.1. Heä soá keát nhoùm rieâng phaàn
Phöông phaùp (Cole, 1957)
Böôùc 1. Phaân chia taäp hôïp oâ maãu thaønh hai phaàn nhö sau: 
Nhöõng oâ baét gaëp loaøi caây quan taâm
Nhöõng oâ vaéng maët loaøi caây quan taâm
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

Böôùc 2. Tính heä soá keát nhoùm cuûa nhöõng loaøi khaùc treân töøng
nhoùm oâ vaéng maët vaø coù maët loaøi caây quan taâm - töông öùng kí
hieäu laø C1 vaø C2.

Böôùc 3. So saùnh caùc heä soá keát nhoùm ñaày ñuû (C2) vôùi heä soá
keát nhoùm rieâng phaàn (C1) baèng thoáng keâ T:

T =  
C 2 - C 1

 SC1 + SC2
 T =  

C 2 - C 1

 SC1 + SC2
 (4.36)
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

• Trong ñoù:
SC1 = sai soá cuûa heä soá keát nhoùm treân nhöõng oâ coù maët loaøi thöù
3. 
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

SC2 = sai soá cuûa heä soá keát nhoùm treân nhöõng oâ vaéng
maët loaøi thöù 3. 
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

N1 = toång soá oâ baét gaëp loaøi thöù 3.

N2 = toång soá oâ vaéng maët loaøi thöù 3.

a1, b1, c1 vaø d1 = taàn soá oâ trong baûng cheùo duøng ñeå tính quan
heä giöõa loaøi 1 vaø 2 treân nhöõng oâ baét gaëp loaøi 3.

a2, b2, c2 vaø d2 = taàn soá oâ trong baûng cheùo duøng ñeå tính quan
heä giöõa loaøi 1 vaø 2 treân nhöõng oâ khoâng baét gaëp loaøi 3.
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Heä soá keát nhoùm rieâng phaàn

Giaû ñònh:
H0 = Khoâng coù keát nhoùm rieâng phaàn.

Ha: Coù keát keát nhoùm rieâng phaàn.
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Heä soá keát nhoùm rieâng phaàn

Quy taéc quyeát ñònh:
Neáu T < T05 = 2,0, thì söï khaùc bieät giöõa heä soá keát

nhoùm rieâng phaàn vôùi heä soá keát nhoùm ñaày ñuû laø khoâng
coù yù nghóa.



11/11/2009 91

Ví duï

o Ñieàu tra 500 oâ maãu vôùi kích thöôùc 0,25 m2 (Baûng
4.4).

Heä soá keát nhoùm rieâng phaàn
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Bảng 4.4. Kết nhóm riêng phần giữa C.  pallescens (loài 2) và R. acer (loài 1) 
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

Vấn đề đăt ra:
1. Tìm hệ số kết nhóm đầy đủ giữa loài 

Ranunculus acer (loài 1) và Carex 
pallescens (loài 2) khi có mặt cả loài ưu 
thế Alopecurus pratensis (loài thứ 3)? 

2. Ngoài ra, hãy cho biết loài thứ 3 đóng vai 
trò như thế nào trong quan hệ này?
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

Giaû thuyeát
H0: Söï coù maët loaøi thöù 3 treân oâ maãu khoâng aûnh höôûng
ñeán quan heä giöõa loaøi 1 vaø 2.
Ha: Söï coù maët loaøi thöù 3 treân oâ maãu coù aûnh höôûng ñeán
quan heä giöõa loaøi 1 vaø 2.
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

Giaûi:
Böôùc 1. Tính hệ số kết nhóm đầy đủ giữa
loài 1 và 2 là + 0,31. 
Böôùc 2. Tính sự kết nhóm riêng phần giữa
loài 1 và 2 trên những ô mẫu vắng mặt loài
3 (C1) và có mặt loài 3 (C2). 
Kết quả: C1 = + 0,26; C2 = + 0,45 
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

Böôùc 3. Kieåm tra söï sai khaùc giöõa hai heä soá
töông quan rieâng phaàn (C1 vaø C2) baèng thoáng keâ
T. Keát quaû: T = 1,28.
Vì T = 1,28 < T05 = 2,0, nên sự khác biệt giữa hai
hệ số kết nhóm riêng phần là không có ý nghĩa.
Điều này có nghĩa là sự xuất hiện của loài thứ 3 
trong các ô nghiên cứu không ảnh hưởng đáng kể
đến sự phân bố của loài 1 và loài 2.
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Moät soá löu yù
1. Neáu caùc heä soá töông quan rieâng phaàn khoâng khaùc

nhau thöïc söï, thì söï keát nhoùm naøy khoâng phaûi do 
quan heä qua laïi giöõa caùc loaøi.

2. Ngöôïc laïi, söï cuøng coù maët cuûa caùc loaøi treân nhöõng
oâ nghieân cöùu laø do söï töông ñoàng veà bieân ñoä sinh
thaùi cuûa chuùng. 

+ Ví duï phaân tích keát nhoùm rieâng phaàn
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

(3) Hệ số kết nhóm đa biến

Phân tích quan hệ của loài 1 loài cây với hai
hay nhiều loài cây khác nhau. 

Cách giải quyết:

Giả thiết chúng ta cần nghiên cứu quan hệ
giữa 3 loài cây. 
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

Trước hết, tính các quan hệ đơn giữa loài 1 
và 2, 1 và 3, 2 và 3. 

Khi tính quan hệ giữa loài 1 với hai loài 2 
và 3, chúng ta cũng lập bảng 2*2; trong đó
dấu hiệu 1 là tần số bắt gặp loài 1, còn dấu
hiệu 2 là tần số cùng bắt gặp cả hai loài 2 và
3. 
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4.4. SÖÏ KEÁT NHOÙM RIEÂNG PHAÀN

Sau đó, bằng cách thông thường chúng ta
tính hệ số kết nhóm giữa loài 1 với hai loài
kia. 

Như vậy, hệ số kết nhóm đa biến chỉ ra mức
độ liên hệ của các nhóm sinh thái. 
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NHỮNG LƯU Ý KHI TÍNH SỰ KẾT NHÓM

1. Phải định nghĩa rõ ràng về tổng thể nghiên cứu
hay đối tượng thu thập dữ liệu.

2. Tổng thể phải ở trạng thái ổn định.

3. Sử dụng kích thước ô nghiên cứu thích hợp. 

4. Số lượng ô mẫu phải đủ lớn.

5. Chỉ nghiên cứu quan hệ giữa những loài cây
đáng quan tâm.
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